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Preface 

The intended audience, document organization, and conventions used herein are 
described. Related documentation is identified as are instructions for accessing other 
electronic product documentation. 

Audience 

This document is intended for technical users who have a basic level of understanding, 
familiarity and experience with network test and measurement equipment. 

Conventions 

The following conventions are used in this document: 

Grayed-out Font 

Indicates a command or a feature is not available in the current release. 

Courier Font 

Illustrates an example command or a concept. 

Light Blue Font 

A clickable hyperlink to a referenced source. 

Normal Bold Font 

A concept or idea important enough that the reader’s attention is being explicitly focused. 

Red Font 

Additional information for the topic. 

Note: This symbol means take note. Notes contain helpful suggestions or references to 
additional information and material. 

 

Caution: This symbol means be careful. In this situation, you might do something that 
could result in equipment damage, undesired result or loss of data. 

Obtaining Latest Documentation and Software 

Please visit the ThinkRF website at http://www.thinkrf.com/documentation/ to obtain 
the latest product documentation. Software and firmware releases are also available on 
the ThinkRF website at https://support.thinkrf.com. 

Document Feedback 

Please send any comments regarding ThinkRF documentation to support@thinkrf.com. 
We appreciate your feedback. 

http://www.thinkrf.com/documentation/
mailto:support@thinkrf.com
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Obtaining Technical Assistance 

For all customers who hold a valid end-user license, ThinkRF provides technical 
assistance 9 AM to 5 PM Eastern Time, Monday to Friday. Contact us at 
https://support.thinkrf.com or by calling +1.613.369.5104. 

Before contacting support, please have the following information available: 

• ThinkRF product's model, serial number (S/N), version (located on the 
identification label on the product's underside), and firmware version.  

• The S240v5 version. 

See Viewing Device Information section to obtain the information for the two points 
above. 

• Versions of any ThinkRF software you are using, including any API libraries or 
third-party applications. 

• The operating system and version you are using. 
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S240v5 Overview 

The S240v5 Real Time Spectrum Analysis software (hereafter referred to as S240v5) is a 
spectrum analysis application designed to work with ThinkRF Real Time Spectrum 
Analyzers (RTSAs) starting with the R55x0 and R57x0 devices. This easy-to-use 
application provides standard and advanced spectrum analysis features including 
frequency and bandwidth controls, power measurements, triggering and multiple marker 
and trace configurations, to name a few. 

ThinkRF RTSA devices are high-performance software-defined RF receivers, digitizers 
and analyzers. With patent-pending software-defined RF receiver technology, RTSA 
devices provide industry leading combined sensitivity, tuning range, instantaneous 
bandwidth (IBW) and scan rate. A hybrid RF receiver front-end (RFE) combines super-
heterodyne, direct-conversion and direct digitization technologies with wide-band and 
narrow-band ADCs. Additionally, it provides hardware-based triggering and capture 
control, thereby enabling sophisticated sweeping and real-time capture. 

S240v5 can be used to measure and analyze signals such as Wi-Fi, Bluetooth and LTE, 
and offers cursors and markers to track specific frequencies. Sophisticated FPGA-based 
frequency-domain level trigger in ThinkRF RTSA products enables the capture of elusive, 
time-varying signals across an instantaneous bandwidth (IBW) of up to 40MHz. Captured 
signal data can also be recorded to a CSV file for later replay. 

S240v5 is built in Python 3 and runs on a Python 3 version of the ThinkRF PyRF 
development framework called PyRF3, which ThinkRF has open-sourced under BSD 
licensing. PyRF3 handles low-level details of connection, real-time acquisition, and signal 
processing. It provides feature-rich classes and comes with several examples with full 
source code, all specific to the requirements of signal analysis. PyRF3 is available to 
download from ThinkRF’s Knowledge base site. 

Note: This document version 1.3 of S240v5 User Guide works in particular with S240v5 
software v5.1.2 or higher.  Recommend to download the latest S240v5 if your version is 
older. 

User Interface 

S240v5 is a new release of the S240 application with improved and easier to use 
features requiring fewer mouse clicks. It focuses on Center, Span, Start and Stop 
frequency settings coupled mode rather than on RFE modes as its primary control model. 
The application includes controls for Frequency, Amplitude and Bandwidth with 
additional plots such as Spectrogram, Persistence and Time-Domain data. It has also 
several measurement tools and the ability to record and playback signal data. 

Note: This section provides an overview of the S240v5 user interface. See Configuring 
S240v5 for details on how to use individual settings and options for each control. 

Spectral Plot and Configuration Panels 

The application is centered around its main Spectral Plot display (as shown in Figure 1). 
The Spectral Plot shows the processed power spectrum of the time-domain signal as a 
function of frequency in real-time. Current signal capture settings – frequencies, 

https://support.thinkrf.com/
https://support.thinkrf.com/
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amplitude, resolution and video bandwidths (RBW and VBW), and sweep time and speed 
– are displayed below the plot. Trace, cursor (when available) and marker information are 
displayed above the plot. 

 
Figure 1: The S240v5 User Interface and Its Main Spectral Plot 

Configuration panels surround the Spectral Plot section as such: 

• Left-side panels contain frequently used settings for signal monitoring – 
Amplitude, Frequency and Bandwidth.  

• The near-right top panel contains analysis settings of a topic that is selected by 
the control buttons on the far-right section of the S240v5. 

• The near-right middle panel is currently unused, expanding and contracting to fill 
the space between the selected analysis panel and the device location panel. 

• The near-right bottom panel contains a permanently displayed geolocation 
tracking data for the currently connected R57x0 device. 

All configuration panels and control buttons are shown by default but can be hidden by 
opening the View menu and deselecting the Show Control Panels checkbox. In this 
mode, the plot section fills the application window. 

Control Buttons 

The following table summarizes the control buttons available in the far-right section with a 
brief description of their function. 

Control Button Function 

Continuous Capture Starts continuous capture and display of signals. 

Pause Capture Pauses the Continuous Capture. 

Single Capture Performs a single capture and display of the signal. 



S240v5 Overview 

ThinkRF S240v5 RTSA Software User Guide 9 

Control Button Function 

Traces Displays on the near-right top panel options for configuring up 
to 6 individual traces on the Spectral Plot. See Adding Traces 
section for more information. 

Marker / Peaks Displays on the near-right top panel options for adding up to 
12 markers to signal trace(s) and configuring signal peak 
detection. See Adding Markers section for more information. 

Triggers Displays on the near-right top options for enabling and 
configuring a frequency-domain level trigger for signal 
capture. It is available only when spans are from 40MHz to 
100.001kHz. See Configuring A Trigger section for more 
information. 

Spur Mitigation Displays on the near-right top panel options to activate and 
configure spur mitigation or correction. See Configuring Spur 
Mitigation section for more information. 

Measurements Displays on the near-right top panel options for performing 
channel power or occupied bandwidth measurement. See 
Configuring Measurement Settings section for more 
information. 

Save Data Displays on the near-right top panel controls for saving signal 
data and application state for future playback. See Saving 
Signal Data section for more information. 

Load Data Pops up a file dialog for loading of previously saved signal 
data and application state for playback. See Playing Back a 
Recorded Signal section for more information. 

Preset Restores S240v5 to the application start-up state. See 
Restoring S240v5 Defaults section for more information. 

Demodulate Pops a modal dialog for the purposes of visualizing and 
demodulating signals in AM or FM modulations. See 
Demodulate Signals section for more information. 

Spectrogram Adds a spectrogram waterfall display of captured signals 
below the Spectral Plot. See Display Spectrogram section for 
more information. 

Persistence Adds a persistence plot display of captured signals below the 
Spectral Plot. See Display the Persistence Plot section for 
more information. 

Time Domain Adds a time-domain (I/Q) plot display of captured signal below 
the Spectral Plot. It is available only when spans are 40MHz 
or lower. See Display the Time Domain Plot section for more 
information. 

Menu Bar 

The user interface has a menu bar at the top that offers a tidy location for additional 
controls for the RTSA device or the application itself. 
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Menu  Options Function 

File Load Settings Loads a previously saved configuration file, as 
explained in Loading Configuration Settings. 

Save Settings Saves the current S240v5 settings into a .config file, as 
explained in Saving Configuration Settings. 

Exit Closes the application. 

Device 
 

Connect... Loads the Open Device dialog to allow for connecting 
to another RTSA device. 

Connected Device 
Info 

Opens the Connected Device dialog to show the 
device information, as explained in Viewing Device 
Information. 

Internal/External 
Digitizer 

Checkboxes for selecting an internal (default) or 
external digitizer for processing RTSA’s signal. 

Restart 
Connected Device 

Restarts the connected RTSA device. 

View Take 
Screenshot... 

Captures the current S240v5’s user interface view, as 
explained in Capturing a Screenshot. 

Show Control 
Panels 

Shows (default) or hides all the control panels. 

Help RTSA S240v5 
User Guide 

Opens the S240v5 User Guide documentation. 

 

See Configuring Device Options for more information on the Device menu. 



Getting Started 

ThinkRF S240v5 RTSA Software User Guide 11 

Getting Started 

Before installing S240v5, ensure that your PC meets the following minimum system 
requirements: 

• Operating System: Windows 7, 8, 10 (32-bit or 64-bit). 

• RAM: 4 gigabytes (GB). Recommend: 8 to 16 GB improves the performance. 

• Hard Disk: 1 GB available. Recommend: SSD drive improves the record and 
playback performance. 

Note: An Internet connection is required to download S240v5 from the ThinkRF website. 

Installing S240v5 Software 

Download the S240v5 installer from the ThinkRF website to install the software on your 
computer. 

1. Open a web browser and go to https://support.thinkrf.com/support/home – you 
will be required to log into the site if haven’t done so. 

2. In the New Release/Updates section, locate the S240v5 software and download 
the file to your computer. 

3. Double-click on the executable file to launch the Setup Wizard, then follow the 
prompts to select your installation options and install the software. 

4. On the Ready to Install prompt screen, review your installation settings. Click 
Install to proceed with the installation, or Back to change your settings. 

5. When the Setup Wizard has completed software installation, click Finish to exit 
the Wizard. 

Notes:  
 

• If you get a permission error during the installation, right-click the install file and 
select Run as administrator.  

• Also, you may receive an installation error from a third-party anti-virus software, in 
which case you are advised to disable the virus scanner prior to installing S240v5. 
However, the common “code 299” error can be safely ignored. 

• After installation, if your anti-virus software quarantines the S240v5 during run time, 
please add an exception to the anti-virus software for S240v5 and try again. 

Connecting to an RTSA Device 

Connect to an RTSA device to view its real-time signal data in the S240v5 application. 
When launched, S240v5 will automatically detect and display a dialog listing compatible 
RTSA devices that are connected to the network subnet on which the host computer of 
the application resides. The users also have the option to manually enter a known IP 
should it not be on the same subnet.  

https://thinkrf.com/
https://support.thinkrf.com/support/home
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Caution: A new connection to an RTSA device that is already in use will disrupt or 
disconnect the existing capture application. Current RTSA devices do not handle multiple 
simultaneous connection. 

1. Launch S240v5 from your computer's Start menu or desktop icon shortcut (if 
installed). The application will display an Open Device window. 

2. Select an RTSA device from the list of “Devices Detected on Local Network”. 

If a RTSA device of interest is not on the list, you can either click the Refresh 
button to update the list or enter the IP address of the device manually in the 
Manually Enter Device IP field. 

3. Click Connect. Note that an entry of a detected device can be double-clicked to 
connect directly. 

Upon successful connection, the S240v5 user interface will start displaying 
captured signal using the default application settings. 

4. To connect to a different RTSA product, click on the Device menu and select 
Connect.... The application will display the Open Device window. Repeat steps 
2 and 3 as needed. 
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Configuring S240v5 

The S240v5 RTSA application provides several options for controlling and displaying 
signal captured through a ThinkRF RTSA product. For example, you can specify the 
frequency span and amplitude, create a trigger, adjust the RBW and VBW settings, add 
or remove traces, and add and manipulate markers.  

Note: This section provides explanation regarding how to use S240v5 to configure the 
connected RTSA, it does not go into details what the configuration on the device entails. 
Refer to the RTSA product specific documentations for such details (see Obtaining Latest 
Documentation and Software). 

Configuring Signal Capture 

This section describes the settings that affect the signal capture and display. 

Configuring Amplitude Settings 

The Amplitude Settings panel at the far-left top panel manages levels and offset for the 
device and the Spectral Plot. 

Reference Level: Controls the upper value of the plot’s Y-axis, which indicates the 
maximum power level that can be displayed. It can be changed to bring the signal into 
view when necessary. Default 10dB. 

Scale / Division: Controls the distance between the horizontal lines (Y-axis tick marks) 
on the plot display, useful for zooming in or out to the signal. The range is 1dB to 16dB, 
with 10dB as the default. 

Reference Offset: Changes the signal’s location within the plotted scale. Also, uses for 
adjusting known discrepancies between the displayed signal and the actual signal 
reference location. Does not affect the input signal. Default 0dB. 

Attenuation: Applies a fix attenuation value to the device, which has the effect of raising 
or lowering the noise floor in the display. A default of 30dB is meant to protect the device 
from excessive signals on connection, while changing to 0dB for best dynamic range. 

Gain Block: Applies a gain setting to the RTSA device (not available for RTSA -408 
model). Increasing gain lowers the noise floor, improving SNR. 

HDR Gain: Applies gain setting for RTSA’s High Dynamic Range (HDR) RFE mode, 
which is enabled when the span drops to 100kHz and below with frequency ranges 
above 50MHz. Increasing gain lowers the noise floor, improving SNR. 

Configuring Frequency Settings 

Basing on chosen span and frequency ranges, the Frequency Settings at the far-left 
middle panel leads S240v5 to configure the device to switch between sweep-tuned mode 
or block capture mode as well as the RFE mode. Span and frequency ranges also affect 
down-sampling rate and dynamic ranges of the device as managed by S240v5. 

Center – Span – Start – Stop: These four parameters run in coupled mode such that 
when one of the is changed, they all change when necessary to maintain accurate 
frequency endpoints, center frequency, and span. The minimum span is 50kHz, which 
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can be reached by adjusting Start or Stop in the direction of the other endpoint. When 
reached, further adjustments move the Center frequency with the Span remaining at 
50kHz. Hitting the minimum or maximum frequencies for the device adjust these four 
parameters appropriately until minimum frequency is reached. 

Note: The Spectral Plot can appear to shudder or jump at times during frequency and 
span adjustments as frequency thresholds are crossed triggering RFE modes switching 
by S240v5 to the device. 

The coupled mode causes the S240v5 to configure the RSA device as such:  

• When a frequency range includes or is at the 50MHz or lower, the device uses 
the direct-digitization (baseband) technology with an IBW of 50MHz for the 
50MHz or lower range. Data is trimmed from this 50MHz IBW to fit the Span 
required. 

• For a frequency range beyond 50MHz with a Span value 

o above 40MHz, the device is set to use super-heterodyne technology in a 
swept-tuned mode with a sweep IBW of 40MHz. 

o from 40MHz to 100.001kHz, the device will use block capture mode with 
IBW of 40MHz but applies increasing down-sampling starting at 25MHz 
in order to enable smaller RBWs with reasonable sweep speeds. 

o at or below 100kHz, the device is switched to use block capture in HDR 
technology with an IBW of 100kHz. In this setting, the default RBW value 
is 3Hz, but in manual mode, the RBW could go down to 1Hz. 

Caution: Increasing Span while leaving RBW in the manual mode at a very low value will 
dramatically increase sweep times, which might make S240v5 less responsive. 

 

Note: Full span can be reached by placing the mouse cursor on top of the Span field and 
scroll the middle mouse button forward quickly until the maximum frequency is reached. 

Fine Tune: This adjustment is disabled in the current version of S240v5. 

Step: The step value for changing any frequency fields in this panel when pressing the 
up/down  arrows or for when using the middle mouse scroll on top of Center, Start and 
Stop fields (but not on Span which has its own mouse scroll “spin” steps). 

External Reference Clock: Select this checkbox when there is an external 10MHz sync 
input provided to the connected device at the 10MHz IN port. 

GPS Reference Clock: Visible only when connected to an R57x0 device. Select this 
checkbox when one or more R57x0 devices are being coordinated using their GPS 
clocks. This is appropriate for widely separated RTSA devices in a distributed system. 

Configuring Bandwidth Settings 

S240v5 provides the resolution bandwidth (RBW) field for specifying the frequency 
distance between two frequency points and the video bandwidth (VBW) field to reduce 
noise on the trace and make signals, that would otherwise be obscured by noise, easier 
to see on the display. 
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Auto RBW: When selected (by default), causes the RBW and VBW to be recalculated on 
every frequency range adjustment to provide the optimum balance of resolution and 
speed. 

RBW: Increase the RBW for faster sweep speeds or lower for finer signal resolutions. 
Adjusting this control directly will disable Auto RBW. There is a hard limit of 500,000 
maximum number of data points on the man display to prevent the S240v5 becoming too 
resource consuming. This limit could affect the manual RBW value as the Span 
increases. 

Caution: Usage of small RBWs in the Hz range (with Span under 5 MHz) could cause 
very slow sweep time due to the large data points for processing, which could take up to 
1minute or more for RBW of 10 Hz or lower. Recommend changing RBW to a value 
above 1 kHz before using the Demodulating Data feature, since the Demodulation does 
not use this RBW setting. This is to allow for a smoother switching back to the main panel 
after closing the Demodulation panel. 

VBW: Tracks RBW whenever it changes. VBW can be changed on its own, however, to 
better isolate the signal from noise as mentioned above. 

VBW Filter: Choose a filter to apply to the VBW. Defaulted to Synchronous. 

Configuring A Trigger 

Note: If a signal acquisition is configured for spans from 40MHz down to 100.001kHz and 
a frequency range above 50MHz, the near-right trigger panel will be enabled for 
configuring a trigger. 

To set up a trigger, 

1. Click the Triggers button on the right to access the TRIGGERING control panel. 

2. Select a Trigger Type in the drop-down list. Default to Free Run (no triggering). 

3. If frequency-domain Level trigger type is selected, the signal capture is defined 
by the Start and Stop frequencies and the power Level. 

• In the Start field, specify the minimum frequency that can trigger a signal 
capture. 

• In the Stop field, specify the maximum frequency that can trigger a 
signal capture. 

• In the Level field, specify the minimum power threshold that can trigger a 
signal capture.  

• The Spectral Plot will also show a drag-able rectangle (see Figure 2) 
representing Level trigger parameters: minimum frequency (left 
boundary), maximum frequency (right boundary), and power level (top 
boundary).  

When a signal has satisfied this trigger condition, the post-triggered signals are 
captured and sends to the S240v5 for processing and displaying. 

Hint: To quickly change the trigger settings, mouse dragging could be applied to the 
whole rectangular box when the mouse cursor is within the box or to each boundary line 
when the mouse cursor is right on top of the line. 
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4. The Pulse trigger option is to be used with an external synchronized pulse trigger 
setup, from which a pulse signal is provided to the RTSA's GPIO port to start the 
capture. Hence, external hardware will be required for this trigger setup. Contact 
ThinkRF for more information (see Obtaining Technical Assistance). 

Notes:  
- The Frequency Settings panel is disabled while a trigger is in operation, switch back 

to Free Run mode in order to change frequency and span settings.  
- Toggling the Pause and Continuous or Single Capture buttons may be required to get 

the capture going when switching back to Free Run as the device might still be 
waiting for a valid trigger event. 

 
Figure 2: Level Trigger for A Signal Capture 

Configuring Measurement Settings 

S240v5 provides power measurement settings such as the channel power measurement 
for a specific span in the Spectral Plot or the bandwidth occupied of a given channel 
power percentage. 

5. Click the Measurements button on the right-side of S240v5 to access the 
Measurements control panel. 

6. Click on Channel Power button to open its settings and view computed result. 
This will disable the Occupied Bandwidth measurement if activated. 

• Start: the lower boundary of the channel power region of interest 

• Stop: the upper boundary of the channel power region of interest 

The frequency values are filled with default values (50% of the current spectrum) 
upon activated. These values are also reflected on the Spectral Plot as the 
boundaries of a transparent blue high-lighted channel power region of interest, as 
shown in Figure 3. 
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Hint: Mouse dragging could be applied to the high-lighted region or to each vertical line 
to quickly change the frequency settings and the channel power computation. 

The measured channel power result is displayed in the Channel Power control 
section. 

7. Click on the Channel Power button again to deactivate it. 

8. Click on Occupied Bandwidth to measure the bandwidth occupied by a specific 
portion of the channel power. This will disable the Channel Power measurement 
if activated. 

• The Occupied Bandwidth measurement is defined by the Power % of the 
spectrum span display in Spectral Plot, which is defaulted to 99.999% 
upon activated. 

• The Spectral Plot will show at the center a blue high-lighted region 
representing the calculated occupied bandwidth of the percentage 
specified. 

The occupied bandwidth result is displayed in the Occupied Bandwidth control 
section. 

9. Click on the Occupied Bandwidth button again to deactivate it. 

 
Figure 3: Channel Power Measurement 

Customizing the Spectral Plot Display 

S240v5 supports up to six active power spectral traces on the Spectral Plot and up to 
twelve markers for peak detection and analysis on the active traces. Additionally, up to 
two horizontal and two vertical cursor lines may be added to the Spectral Plot to mark 
specific power or frequency locations, respectively. A crosshair cursor is also available for 
convenient reading of the power and frequency values at the crosshair point. 
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Adding Traces 

You can configure up to six active traces in the signal display. By default, the first trace is 
initially configured to actively display the power spectrum of the captured signal. The 
following procedure applies to each trace: 

1. Click on the Traces button to access the Trace control panel. 

2. Activate a trace by clicking on a number (from 1 to 6) in the trace list at the top  
of the Trace panel. The trace will be defaulted to “Clear/Write” and “Active”. 

3. In the Trace Type drop-down list, select a display mode for the trace: 

Trace Type Description 

Clear/Write Plot the power spectrum result of each captured signal. 

Max Hold Plot and hold the maximum power values across frequency for 
the captured signals. 

Min Hold Plot and hold the minimum power values across frequency for 
the captured signals. 

Average Plot the moving average power values of the number of 
captures set in Trace Average field. 

 
4. The Trace Color field may be used to select a different color for the trace if 

desired. 

5. In the View / Blank drop-down list, select a state for the trace: 

View Type Description 

Active Trace is active on the Spectral Plot. 

View Pause the current trace, which is equivalent to Trace Hold on 
other spectrum analyzer equipment. 

Blank Trace is turned off. 

 
Repeat steps 2 - 5 for each additional trace (to a maximum of six). 

Note: Each trace’s type, color and status are also indicated on the information section 
above the Spectral Plot. Except for the color, the trace’s setting will remain the same until 
it is turned off. 

6. Click the Clear Trace button to reset the selected trace on the display. This 
means that if the trace is of Min Hold, Max Hold or Average, accumulated results 
will be discarded and the trace will start fresh. 

7. Click the Clear All Traces button to reset all traces on the display. 

8. To turn off a trace, set View / Blank to the Blank option. 

Adding Markers and Peak Findings 

Up to twelve markers may be added, configured and have their results saved to a CSV 
file. Markers are positioned on the Spectral Plot in association to an active trace to 
identify peaks or differences in power and frequency relative to another primary marker. 
When peak search is applied, the currently selected marker is positioned at the highest 
peak on the signal. 
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Follow these steps to use the Marker / Peaks feature: 

1. Click on the Marker / Peaks button to access the Markers / Peaks control panel. 

2. Select a marker (from 1 to 12) from the marker list at the top of this control panel. 

3. In the Marker Mode drop-down list, select a mode: 

Mode Description 

Normal 
(Primary  
Marker) 

The marker tracks the amplitude (power) value of the active 
trace but remains at the same frequency position, unless 
Continuous Peak search is applied. Upon first activation, the 
marker is positioned at the Center frequency by default. 
 
The marker appears as a diamond shape in the display. 

Fixed 
(Primary  
Marker) 

The marker stays at the same frequency and power level, 
regardless of changes in the amplitude of the incoming signal. 
 
The marker appears as a plus-sign shape in the display. 

Off The marker is removed from the display. 

Delta <n> When more than one marker is active and at least one is a 
primary marker, a marker may be set as a delta marker 
relative to a primary marker <n>. For example, if there are two 
primary markers on the signal display, you can designate 
Marker 3 as Delta 1 (relative to marker 1) or Delta 2 (relative to 
marker 2). 
 
The delta marker appears on the display as an inverted triangle 
icon with its marker and delta numbers hovering above it.  

Note: A currently selected marker (and the only) will be high-lighted with purple color in 
the display and have its power and frequency values shown on right side of the 
information section above the Spectral Plot. Other active markers will be identified by no-
fill marker shapes. All markers’ value may be displayed in a Marker Table as mentioned 
below. 

4. In the Marker Trace field, assign the marker to an active trace from the trace 
drop-down list containing all active traces on the display. 

5. In the Frequency field, specify a frequency value to position the marker.  

Hint: A marker can be clicked and dragged directly on the display to a desired frequency 
position. This action will also make the marker as the currently selected. 

6. The Power field, read-only, shows the power level of the marker in real-time. 

7. Optionally, a marker can be configured to indicate a peak in its associated trace 
by clicking on one of the following buttons: 

• Peak Search: positions the marker at the highest peak signal of the 
current trace. 

• Next Peak: positions the marker at the next highest peak signal, 
wherever it occurs. 

• Next Peak Left: positions the marker at the highest peak signal to the 
left of the current marker position. 
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• Next Peak Right: positions the marker at the highest peak signal to the 
right of the current marker position. 

• Marker -> Center: changes the center frequency to match the current 
marker position. 

8. Select the Continuous Peak checkbox to have the Normal or Delta (not Fixed) 
marker tracks the highest peak on each new capture as it occurs on the display. 
When this checkbox is selected, all the Next Peak options are not effective as the 
results are quickly overwritten by the Continuous search. 

9. Select the Pk Threshold checkbox to enable definition of the minimum power 
threshold for the peak detection. Markers are not assigned to peaks that fall 
below this power level. 

Repeat steps 2 to 9 for each additional marker (to a maximum of twelve). 

10. Optionally, select the Marker Table On checkbox to display a table listing all 
active markers (with their corresponding marker mode, trace assignment, 
frequency, and power level) below the Spectral Plot. 

Hint: Entries in the Marker Table are clickable. The clicked-on entry will become the 
currently selected marker on the display. 

11. Optionally, the information of the current markers (power level and frequency 
position) may be saved in a CSV file by clicking on the Save Marker Table 
button. Specify a file name and location in the CSV File dialog. The initial save 
location for the marker table is the default folder created at installation time. 

12. To remove a single marker, change the Marker Mode field to Off. 

13. To remove all markers from the display, click All Markers Off. 

Adding Cursors 

The cursor buttons are available at the top of display. The selected cursor button will turn 
green. 

1. To add a horizontal cursor, click the H1 or H2 button. 

2. To add a vertical cursor, click the V1 or V2 button. 

When selected, the horizontal or vertical cursor’s spin-box will appear above the Spectral 
Plot, allowing for specification of the cursor position. By default, the cursor line will be 
positioned in the center of the display. The cursors are also draggable by mouse over the 
top of the cursor, click and drag them to the desired location on the plot display. 

3. To add a crosshair cursor, click the Crosshair button ( ). 

When the Crosshair cursor is activated, activated horizontal or vertical cursors are no 
longer mouse selectable for dragging; use their spin-box fields to change the position. 

4. To remove any cursors from the display, click on their button again. 

Configuring Spur Mitigation 

The S240v5 RTSA application provides a set of settings to correct for the effects of input-
related spurs. The application’s algorithm identifies the spur level and suppresses it using 
the Spur Mitigation control.  From release version 5.1.2 onward, the control will be 
available only when: 
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• The Stop frequency is not at maximum and the Start frequency is from 
50MHz or higher; or 

• The Stop frequency is at max and the Start frequency is from 52MHz or 
higher. 

These limits are because there is no frequency tuning in DD range (DC to 50MHz) & a 
shift in the center frequency is needed for the spur mitigation algorithm to work. 

To use the feature, 

1. Click on the Spur Mitigation button on the right-hand side panel to access the 
Spur Mitigation control panel. 

2. When available at the valid frequency range, select the Spur Mitigation 
checkbox to enable. 

3. In the Spur Level field, enter a power level value to target a specific spur(s) that 
has the power level at that value or higher. 

4. In the Spur Bandwidth field, enter a bandwidth value to correct the spur.  

Note: When Spur Mitigation is applied, the signal display’s update rate will be affected. 
The finer the RBW, the slower the update rate. 

Known Limitations of the Spur Migitation Feature 

The Spur Migitation algorithm used is called “Dual Scan” (also known as “Dual Pass” or 
“Two Pass”), where a band is swept twice with a small frequency shift. Any signal activity 
that appears in one scan and doesn’t appear in the other is considered false (i.e. spur) 
and will be removed. This algorithm, like many others, has its own limitations and some 
are listed here: 

• When the injected signal is the same as the center frequency of the sweep’s 
step, in some rare cases, its measured value might be affected by the algorithm. 

• If an input related spur is a signal harmonic, that spur will not be effectively 
removed. 

• The finer the RBW, the slower the spectral display is updated as the algorithm is 
working on the data. 

Configuring Device Options 

Less frequently use device-specific control settings are available in the Device menu on 
the menu bar. The Device menu’s options are: 

• Connect…: Opens the Open Device dialog for selecting or entering a new 
device for signal display and analysis. 

• Connected Device Info: Opens a dialog showing the current device’s statistics 
and location. This dialog can be moved and kept open for convenient viewing 
while S240v5’s controls are still accessible or S240v5 is in full-screen mode. 

• Internal Digitizer: This checkbox is checked by default, indicating that the 
RTSA’s digitizer technology is performing the data capture and digitization for 
subsequent analysis. Enabling this option will deselect the Exernal Digitizer as 
these two digitizers operate exclusively. 
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• External Digitizer: This checkbox is for routing the RTSA’s analog data to an 
external digitizer (such as one with faster throughput or special digital signal 
processing) and bypassing all internal digitizing functions. Selecting this option, 
thus, will deselect the Internal Digitizer as these two digitizers operate 
exclusively. 

Note: The signal display is no longer active when you select this option; however, the 
S240v5 could still be used to control the connected device. 

• Restart Connected Device: Initiates a restart of the connected device. The 
command takes effect immediately and there is no intermediate verification of 
intent. 

Restoring S240v5 Defaults 

The Preset button in the far-right of S240v5 provides a mean to reset all parameter 
values to the application’s start-up defaults. If you want to save your custom settings 
before restoring the system defaults, see the Saving Configuration Settings section. 
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Viewing Signal Data 

Besides the main Spectral Plot, the S240v5 application supports the following additional 
displays: 

• Spectrogram, 

• Persistence plot, and 

• Time Domain plot 

Display Spectrogram 

The Spectrogram (a.k.a. waterfall plot) displays spectrum changes over time in a three-
dimensional view, as shown in Figure 4. Time is displayed on the vertical axis and 
frequency on the horizontal axis. The amplitude of the frequency components is 
expressed by user-adjustable color gradients locating to the left of the display. 

 
Figure 4: Spectrogram Plot 

1. Click on the Spectrogram button located on the far-right of S240v5. The 
spectrogram appears below the Spectral Plot. 

2. The color gradients of the signal display can be enhanced by sliding the triangles 
on the color palette (left side of the display) to adjust the threshold at which the 
signal changes the power levels. This allows for better contrasting of signal levels 
against the noise floor level. 

3. To hide the Spectrogram, click on the Spectrogram button again. 
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Display the Persistence Plot 

The Persistence plot is a view of how long a signal remains present; as the signal grows 
weaker, the trace fades in color to eventually disappear as time lapses, as shown in 
Figure 5. The amplitude is displayed on the vertical axis, and the frequency on the 
horizontal axis. 

 
Figure 5: Persistence Plot 

1. Click on the Persistence button located on the far-right of S240v5. 

The Persistence plot appears below the Spectral Plot or Spectrogram when 
activated. 

2. To hide the Persistence plot, click on the Persistence button again. 

Display the Time Domain Plot 

A Time Domain plot of a captured signal complements the frequency-domain display and 
is useful for visualizing the signal’s voltage level over time. 

The Time Domain plot shows a time-domain waveform in green for in-phase (I) data and 
another in red for the quadrature (Q) data when available. Quadrature data is only 
available when down-sampling applied at frequencies above 50MHz range, which 
happens automatically for Span values of 40MHz down to 100.001kHz. Figure 6 shows 
an example of the time-domain I/Q waveforms. 

 



Viewing Signal Data 

ThinkRF S240v5 RTSA Software User Guide 25 

 
Figure 6: Time Domain Plots 

1. Click on the Time Domain button located on the far-right of S240v5. 

The Time Domain plot appears below the Spectral Plot (or Spectrogram or 
Persistence when either or both are activated). 

2. To hide the Time Domain plot, click on the Time Domain button again. 
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Capturing Signal Data 

In addition to viewing real-time signal data in real time on the S240v5 application, signal 
data and information can also be saved for playback or for further processing by another 
application. 

Capturing a Screenshot 

S240v5 allows for capturing a screenshot of the current window. The screenshot is stored 
in the PNG file format. 

1. Open the View menu and click on Take Screenshot... option. 

2. In the save PNG File window, specify a file name (or use the default) and a 
storage location. 

3. Click Save to save the image. 

Saving Signal Data 

S240v5 allows for exporting real-time signal data in a CSV file to a storage location for 
playback or further processing by another application. Recommends using a fast writing 
storage location (such as onto the host PC’s SSD hard drive) for fast data transferring. 

When saving data, S240v5 also saves a .config file with full application settings and will 
automatically load those settings to restore the visual application state when playing back 
a data file. 

Caution: S240v5 does not impose a limit on the file size for signal recording to a CSV 
file. If recording is not explicitly stopped, the application continues to write data to the file 
until the local hard drive is full. 

To record data to a file: 

1. Click the Save Data button to access the Save Data control panel. 

2. Optionally, enter a comment in the Comments box. The text entered will be 
added to the top of the saved .csv file. This allows, for example, a way to 
describe what the signal is or any necessary details. 

3. Optionally, add a suffix for the filename in Filename Suffix: field. This is 
convenient for differentiating and fast identifying of files within many saved files. 

4. Optionally, click on the destination directory icon ( ) and specify a path in the 
Select Directory window or use the default (a ‘recordings’ directory that is 
created during S240v5 installation, and where the installed directory is). 

5. Click on Save Data to use defaults file name and storage location or see Save 
Data As… in the next step to specify them manually. 

Save Data defaults the file name to ‘csv-<date>-<time>[_suffix].csv’. <date> and 
<time> are system generated and [_suffix] is optional and specified using the 
Filename Suffix: field mentioned above. 

Save Data also defaults the save location to a ‘recordings’ directory specified 

through the  directory field mentioned above. 
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6. If a specific file name and/or storage location for the CSV file is preferred, click 
on Save Data As ... and browse to a location and/or specify a file name in the 
CSV File window, then click Save. 

The RTSA application begins saving signal data to the CSV file. See the Caution above. 

7. To stop saving signal data to the CSV file, click Stop Saving. 

The stored CSV file has the following format: 

!,version,<#> 

!,options,[empty or list RTSA variants, ex: GPS] 

!,comment,[text from the Comments: field] 

!,device_id,b'<manufacturer>,<model>,<SN>,<Firmware #>' 

data,mode,fstart,fstop,size,timestamp 

,<RFE mode>,<value>,<value>,<SPP_size>,<formatted time> 

<power_data1> 

<power_data2> 

. 

. Data of the first package with SPP size (Samples per Packet) 

. 

<power_dataSPP_size> 

[!,geolocation,<Latitude>,<Longtitude>,<Altitude>,<Speed>,<Track>] 

[,<RFE mode>,<value>,<value>,<SPP_size>,<formatted time>] 

[power_data1] 

[power_data2] 

. 

. Data of the second package with SPP size if available 

. 

[power_dataSPP_size] 

[!,geolocation,<Latitude>,<Longtitude>,<Altitude>,<Speed>,<Track>] 

[,<RFE mode>,<value>,<value>,<SPP_size>,<formatted time>] 

. 

. Data of the Nth package with SPP size if available 

. 

EOF 

with 

• bolded font denotes information identifier word, explained in the table below; 

• italicized text emphasizes information to be filled in during saving;  

• <...> denotes persistent data; and  

• [...] as when available. 

The following table describes the information identifiers used in the saved file. 

Identifier Description 

version The S240v5 version 

options The RTSA product’s option (i.e. GPS, WBIQ, etc) 

comment User’s text from the S240v5’s Comments: field 

device_id The RTSA’s identification string (from *IDN? query command) 

data The power value of the captured signal, one per line for each 
sample. The number of data points corresponds to the value 
specified in the size parameter. 

mode The RFE mode of the device during the signal capture: 
- SH (super-heterodyne 40MHz IBW) 
- HDR (high dynamic range, 100kHz IBW) 
- DD (baseband, 50MHz IBW) 
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fstart The start of the frequency range (Hz) 

fstop The end of the frequency range (Hz) 

size Number of data points in a package of a captured signal. A 
CSV file could have many such package. 

timestamp Formatted ISO timestamp representing the time at which the 
data was captured in the device 

geolocation The geolocation data is present in the R57x0 product family 
and is emitted to the file approximately once per second during 
recording. The fields provided are:  

- Latitude (decimal degree) 
- Longitude (decimal degree) 
- Altitude (meter)  
- Speed (meter per second)  
- Track (degree) 

EOF Marker indicating End Of File 

Playing Back a Recorded Signal 

S240v5 can playback a previously recorded signal. 

1. Click the Load Data button to browse for the saved .csv file in the CSV File 
window. 

2. Select the .csv file and click Open (or double click on the file). 

S240v5 first loads the application state stored in the .config file that was created during 
saving the .csv file in the same location. S240v5 then loads the signal data and plays 
back the recorded signal in a loop. 

Playback can use the Pause, Continuous and Single Capture buttons in the same way 
as real time signals are controlled. 

Non-device related controls, such as Spur Mitigation, Measurements, VBW, traces and 
markers, cursors and the three other plots, can be applied to the playback data as well. 
While device related controls, such as Frequency settings, RBW, trigger, and 
internal/external digitizer, are not applicable nor accessible. 

To stop playback of the recorded file, do one of the following: 

• press the Pause Capture button, 

• open a different file for playback (go to step 1. above), 

• connect to a device using the Device > Connect... menu option, or 

• exit the S240v5 application. 
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Demodulating Data 

S240v5 can demodulate AM and FM signals. A modal dialog is launched to control the 
session and the receiver is placed into gapless streaming mode. Launch the 
demodulation panel (see Figure 7 below) by clicking the “Demodulation” button on the 
far-right control panel of S240v5 (refer to Figure 1). 

Note: FM demodulation has been extensively tested on broadcast signals but is 
considered a beta feature for narrow-band FM. AM demodulation is considered an alpha 
feature for all scenarios and not yet tuned down to AM broadcast frequencies. 

Demodulation Panel 

 
Figure 7: Demodulation Dialog 

The demodulation dialog has a control panel on the left side and three graphs that 
dominate the right side. At the bottom, there is a status bar and a slider indicating when 
frames are received from the stream source, which can be a receiver or a file.  

Fields on the Control Panel 

Name Description 

Stream Source A drop box with choices of Receiver and File. When Receiver 
is selected, the device is performing real-time capture in 
stream mode using current settings. When File is selected, a 
previously saved VRT file is ‘connected’ (opened) for playback. 
If a VRT file has not yet been selected, the connection will 
happen when that occurs. 
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File to which IQ 
data is recorded 

Visible when Receiver source is selected in the Stream 
Source drop box. The data path starts at the default 
recordings path, which is a subfolder under the application’s 

install location. Pressing the  folder button next to the path 
opens a dialog that allows the user to name a VRT file or 
choose a directory (although the default recordings directory is 
always the starting point for locations). It is not necessary to 
name recorded files as they are named automatically for the 
time and date of the start of recording. 

File from which 
IQ data is played 

Visible when File source is selected in the Stream Source 
drop box. The directory starts in the recordings folder as 
mentioned above, navigating to your own directory might be 
needed. Saved *.vrt files can be selected for playback. 

Selecting one of these will cause it to be opened and the 
stream contained within to be played. 

Save Stream Enabled when demodulation is active in Receiver source 
mode. The button starts saving the active stream to the 
selected file as described above. Two files are always created 
with the extensions vrt and vrtmeta. Both files must be 

present in the same folder for the stream to be playable. 

Centre (MHz) The frequency to which the Receiver was tuned or to which the 
Receiver was tuned when the File being played was recorded.  

Step (Hz) The number of Hz by which the Center frequency will step 
when the Center’s up and down buttons are pressed. When 
the Step’s up and down buttons are pressed, it’s value 
changes by powers of 10. 

Analysis BW The bandwidth (BW) used to demodulate and filter the signal. 
The FM demodulator, which is the default modulation, defaults 
to 244kHz. The AM demodulator defaults to 15kHz. Options 
are fixed as powers of 2 and are selected using the slider. 

Modulation Type Options are AM and FM (default). 

Demodulate / 
Stop 
Demodulating 

This button starts and stops the demodulation process. The 
stream keeps running when not active and frames are simply 
discarded. 

Amplifier The audio starts at 100% and can be boosted to 300% or 
dropped to zero using the slider. 

De-emphasis 
filter 

FM radio adds pre-emphasis at higher frequencies to 
compensate for spectral noise. This checkbox determines 
whether compensating de-emphasis is applied (ON is default) 
while demodulating the audio.  

Listening / Stop 
Listening 

This button starts the audio stream flowing and is available 
only when the Demodulate button is pressed. The audio can 
be paused at any time, which will empty the audio buffer until 
the button is pressed again. 
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Demodulation Graphs 

Constellation Graph 

The constellation graph is always active when there is a connected device or file. It 
displays the calibrated signal prior to demodulation (i.e. IQ data) on a unity graph, which 

is essentially signal power and phase. The 
quality of an FM signal is denoted by how 
closely the values are plotted to a perfectly 
clean circle. A perfect circle (see Figure 8) 
denotes a clean, strong signal, which will be 
obvious when listening to the demodulated 
signal. As the circle gets more diffuse (see 
Figure 9), the quality of the audio diminishes. 

However, even a completely diffused field of noise might carry a faint signal, at which the 
Amplifier slider can triple the volume as needed. 

Frequency Domain Graph 

The frequency domain graph shows the power spectral 
density of the signal after demodulation. Thus, it is only 
shown while demodulating. An FM signal has an obvious 
signature that can be seen in Figure 7 above. The 19kHz 
carrier is clearly visible while the smaller 38kHz carrier for the 
stereo signal is also visible. Mono stations do not show these 
features but retain the characteristic caterpillar signal shape 
as shown in Figure 10.  

Time Domain Graph 

The time domain graph shows signal 
amplitude in voltage over time, which 
corresponds to the audio that is played 
when the signal is down-sampled and 
sent to the audio system. 

There will be some amount of lag from 
the displayed signal to the audible signal 
owing to the need to buffer the audio 
stream to mitigate the risk of annoying 
dropouts. 

Plotted data is down-sampled significantly in order to improve clarity of the displayed 
signal, but simpler signals, such as speech in Figure 11, provide a clearer relationship to 
the audio buffer lag owing to pauses as shown in that figure. 

How to Use Demodulation 

A few simple scenarios are discussed here.  

To start demodulating a signal, the following steps are needed first: 

• Ensure that the desired signal is centered in the S240v5 main dialog. This can be 
accomplished by typing the frequency in the Center field on the Frequency 

Figure 8: Strong Signal Figure 9: Week Signal 

Figure 10: Mono FM Signal 

Figure 11: Speech Signal 
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Settings panel or by using the Markers / Peaks panel and the Marker->Center 
button to center the signal. 

• The Gain Block field should be set to High.  

• The Attenuation field should be set to 0. This is important in order to prevent 
weak signals from failing to demodulate. 

• Recommend setting RBW to a value at kHz range. This allows for a smoother 
switching back to the main display when the Demodulation dialog is closed. 

At this point, the Demodulate button can be pressed to launch the feature. 

To record a stream to file, simply press the Save Stream button, which is only enabled 
when Stream Source is set to Receiver mode. A pair of vrt and vrtmeta files are 
automatically created and the button’s label changes to Stop Saving Stream. When the 
Stop Saving Stream button is pressed, the final data is written, the metadata is updated 
with total data packets contained, and the files are closed. 

Note that while it is a good idea to rename the vrt and vrtmeta files once a recording is 
completed; however, ensure that both *.vrt and *.vrtmeta files’ name MUST always 
match.  This is important for the playback as mentioned in the next step. 

To play a stream from a file, select File for the Stream Source. Then click the  folder 
button of the File from which IQ data is played field and find the *.vrt file desired.  

As soon as a *.vrt file is selected, the vrt and its associated vrtmeta files are opened and 
the stream begins playing, just as if the original receiver was the source. The context 
data in the metadata file is used to update the stream controls in the Demodulation 
panel at the left, and the controls are frozen as a file has no flexibility where the center 
frequency is concerned for example. 

Modulation Type and Analysis BW can be explored to see what signals are present. 
Amplifier and De-emphasis filter option also remain active during playback. 
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Administration 

In addition to signal capture functionality, the S240v5 application provides additional 
features that allow you to save and store configuration profiles and to customize the 
configuration panel display. 

Saving Configuration Settings 

S240v5 allows for saving current configuration settings in a file that can be reloaded later.  

To save the existing S240v5 settings, 

1. Open the File menu and select the Save Settings option. 

 The RTSA application opens a Configuration File dialog window at the default 
‘settings’ directory that was created during the S240v5 installation. 

2. In the Configuration File window, specify the name and/or browse to a storage 
location for the configuration file. 

3. Click Save. 

S240v5 saves the current application state in a settings file with the .config extension to 
the specified location. The contents of a saved *.config file can be view in a text editor; 
however, manual modification of this file is not recommended. 

Loading Configuration Settings 

S240v5 application settings can be customized basing on a previously saved 
configuration file. 

1. Open the File menu and select the Load Settings option. 

 The application opens a Configuration File dialog window at the default 
‘recordings’ directory created during the S240v5 installation. Navigate to the 
storage location of the .config file to be opened. 

2. Select the .config file and click Open (or double click on the file). 

S240v5 loads configuration settings from the file and updates the application state 
accordingly. 

Viewing Device Information 

Information specific to the connected RTSA device is made visible at all time on the title 
bar of the window as well as the software version of the S240v5 application.  

The information is also made available in a floatable Connected Device dialog, 
accessible by clicking on Device > Connected Device Info. The dialog can be 
positioned anywhere on any screen while still having access to the S240v5 controls and 
display. 

The dialog displays the following information of the RTSA device currently connected to: 

• Model: the device’s model number 

• Serial Number: the device’s serial number 
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• Product Version: the device’s hardware version 

• Firmware Version: the device installed firmware version 

For the R57x0 product family with inbuilt GNSS module, the panel displays the 
following additional position information with real-time updates approximately one 
second apart: 

• Latitude: degrees, minutes, and seconds 

• Longitude: degrees, minutes, and seconds 

• Altitude: meters (m) 

• Speed: meter per second (m/s) 

• Track: the direction of traveling in degrees 

Accessing Product Documentation 

Access to this User Guide PDF document is available in the S240v5’s Help menu. Adobe 
Reader or equivalent software must be installed in order to view this document. 

See Obtaining Latest Documentation and Software for any other documentation related 
to the device or S240v5. 

 

 


